Creating Printable and Online Resources

The Use of Visual Aids in the Primary Classroom

We all know that not all pupils learn in the same way and that we need to try and reach out to each and every pupil. Just explaining an idea or topic to pupils might not be enough, so for the teacher it is much easier to convey the message using a variety of resources, both printed and online. Pupils might visualise better if they see images on a chart or flashcard and this might help them remember more. Playing educational games tailor-made by the teacher for his/her own pupils can be very effective too. Many online activities can be found to aid the learning process of our pupils. We can also create our own online activities to add to these, as they will be more specific to our classroom’s needs.

The pupils also spend a large number of hours within the school, especially in their own classroom. We need to make this environment as appealing as possible to make them feel happy and pleased with the space around them. This will make them more comfortable and thus more receptive to the learning going on around them. Posters and banners hanging around will surely help to create a nice atmosphere within the class and school.

The Benefits of Printable Resources

In the past the main visual aid available for most teachers to use in the classroom used to be the blackboard or the whiteboard. Teachers also prepared handwritten charts to display on their classroom walls and handouts to give out to the pupils. This process took a long time to prepare but a short time to wear out.
Today with the help of ICT we can use desktop publishing software to help us in the creation of resources. There is no more need to spend hours leafing through magazines to find particular pictures, cutting out and sticking them to cardboard, making hand drawings and ruling out charts and handouts to write neatly on them for all to decipher, or to start afresh if you made a simple spelling mistake. Making one copy of a resource and saving it means that you can print out as many copies as you wish. Since it is stored on the computer, you can print it out whenever you need it or if necessary you can also edit it again.

There are various resources that one could create with desktop publishing software. One can create charts, posters or banners for whole class displays, flashcards which can be used either for class display or for individual attention, educational games like matching cards, dominoes or board games, booklets, brochures, notes, handouts and worksheets and much more... All these can be created purposefully to cater for the needs of one’s own pupils.

**The Benefits of Online Resources**

Teachers are today offered the possibility to create websites with information or activities for the pupils. These websites can be either uploaded on the internet or used on individual computers. Pupils can also make websites themselves as part of a project or the end of a task.
Using Print Shop Essentials 11

Print Shop Essentials 11 is a basic desktop publishing software package by Brøderbund. It allows the user to create a variety of material where s/he can be as creative as possible. Mainly it provides libraries of clip-art and templates through a simple interface to build greeting cards, signs, banners, booklets, pamphlets/brochures, business cards, banners, certificates, calendars, postcards, labels, letterheads, envelopes and even websites.

Starting to Use the software

1. Open **Print Shop Essentials 11** software.
2. When the programme opens you will immediately get a dialogue box to choose type of project you would like to create.

![Print Shop Essentials 11 Software](image)

3. On the left hand side of the dialogue box you will get three different categories to select from, namely Business, Home and Community and All Projects. To have the complete selection of options available, click on All Projects.
4. A submenu shows in the middle of the dialogue box where you get to choose from Blank Pages, Booklets, Brochures, Banners, Calendars, Certificates, Greeting Cards, Signs, Postcards, Newsletters and Web Pages among others.
5. When you click on a particular option a preview of the selected project is shown.
6. Select according to the type of project you wish to create and click on the **Next** button.
7. Another dialogue box appears and offers you to choose the method you would like to use to create your project, either **Personalize a Quickstart Layout** or **Start from Scratch**.
8. The **Personalize a QuickStart Layout** provides a wide variety of ready-made sample projects that you can use immediately or edit slightly to meet your needs.
9. The **Start from Scratch** option gives you a blank panel where you can create your publication according to your needs. This option allows you to be creative and even use the layout you chose for a different outcome than that proposed by the package.
   **NB:** You can also use the Greeting Cards layout for creating A5 or A6 booklets, game cards, activity cards. The Brochure can also be used to make flashcards or game cards. The Banners and Signs can also be used to create large board games.
10. Click on the **Start from Scratch** option and click on the **Next** button. You will be prompted to choose the page format you’d like to use, whether it is **Tall** or **Wide**. Make your choice and click on the **Finish** button to move to the **Design Desk**.

### The Menus and Toolbars

The Design Desk of **Print Shop Essentials 11** is quite user-friendly. At the top part of the screen you find the **Menu Bar**, the **Standard Toolbar** and the **Text Toolbar**. At the left hand side of the screen you find the **Object Toolbar** and at the bottom of the screen you have the **Status Bar**.

At the centre of the screen there is the Design Desk which is the work area. The size of this panel varies according to the type of
Creating Printable and Online Resources through PrintShop Essentials 11

project selected. This panel also has a dotted border which shows the printable area of the project.

The Standard Toolbar

1.  
   **The New button** – Use this to open a new project. You get the starting dialogue box to choose the type of project you wish to create.

2.  
   **The Open button** – Use this when you need to open a previously saved project. You will get a dialogue box to choose the location where this project had been saved and to choose the project’s title.

3.  
   **The Save button** – Use this to save the project you are currently working on. If it is the first time you are saving this piece of work, a dialogue box will show from which you can choose the location where to save this project and give it a title you want. If it is not the first time you are saving this project, it will automatically save this latest version upon the previously saved version.

4.  
   **The Print button** – Use this to open the Print dialogue box and choose from the options available to be able to print your work.

5.  
   **The Print Preview button** – Use this to view how the project will be printed.

6.  
   **The Cut button** – Use this when you need to remove an item which is selected in your project from where it is. Automatically this item is saved in the clipboard and could be pasted again in another location or project.

7.  
   **The Copy button** – Use this when you want to copy the selected item.

8.  
   **The Paste button** – Use this when you have copied or cut an item and you want to paste it within your project.

9.  
   **The Undo button** – Use this to reverse the last action. If you keep on clicking it, it will keep on reversing previous actions.

10.  
    **The Redo button** – Use this to restore your last action if you have deleted it through the **Undo** button.

11.  
    **The Colour button** – Use this to apply colour changes. A drop down menu appears and you can select to change colour to an object, to change the colour behind an object or to a line.

12.  
    **The Tint button** – Use this to control the intensity of the colour of the selected objects.
Creating Printable and Online Resources through PrintShop Essentials 11

13. **The Print Shop online button** – Use this to connect directly to the online Broderbund site. It also includes a list of other useful websites.

14. **The Help button** – Use this to enter *The Print Shop Tutorials, The Help System* or *The On-line Resources*.

The Text Toolbar

1. **The Fonts drop down menu** – Highlight the text of which you need to change the font. Click on the down arrow and select the font you like from the list of fonts.

2. **The Size drop down menu** – Highlight the text of which you need to change the size. Click on the drop down arrow and select the size. You can also highlight the text, then click inside the size window to highlight the size and type in the size number. Click on the Enter key of your keyboard and the size is changed.

3. **The Bold, Italic and Underline buttons** – Highlight the text and choose the B button to make the text bold, the I button to make the text Italics and the U button to underline the text.

4. **The alignment buttons** – Click within the paragraph of text and choose one of these buttons to make the text left, centre or right aligned or justified.

5. **The Text Box Shape button** – Click within the textbox, then click on this button. A Text Box Shape dialogue box appears where you can opt from different shapes in which your text could appear. You can also opt for background and outline colour. It also has a tab for Word Balloons which helps you create speech bubbles like we use in comics.

![Text Box Shape Dialogue Box]

6. **The Bullets/Numbering button** – Highlight the text you want to bullet or number and click on this button. The Bullets and
Numbering dialogue appears to tick the options you want to use. Toggle between bullets or numbers from the tabs at the top.

Inserting a Picture from the Art Gallery

1. Click on the Insert Graphic button in the Objects toolbar.
2. The Art Gallery dialogue box opens to show you the available picture within the software.
3. If you want to view all the pictures available, leave the Collections as All and the Graphics Type as All.
4. You can also concentrate your search by Categories.
5. Choose any of the Categories in the given list and click on the + sign next to it to open more subcategories. The pictures in the view area change according to the categories or subcategories you choose.
6. You can also opt to make a specific search for a particular keyword. Type the keyword in the Search box and click on the Find button. The available graphics for that search will be displayed.
7. When you have decided on the picture to choose, click on it and click on the OK button under the Search box or just double click on the picture chosen and it is pasted automatically into your project.
8. If you need to enlarge or reduce the picture, click on the picture to select it, then click on one of the sizing handles and drag outward to enlarge or inward to reduce. **NB. It is always recommended that you use the corner sizing handles to enlarge or reduce pictures so that you keep the aspect ratio of the picture. Using the side sizing handles may distort the aspect ratio of the picture.**
9. Pictures are always pasted in the middle of the project page, so you will need to move it to where you would like it to be placed. Click in the middle of the picture and drag it to the desired place.
10. Pictures can also be rotated from the rotating handle on the right hand side. Click on this handle and drag upwards or downwards to rotate the picture to the needed angle.

**Importing a Picture into the Art Gallery**

1. Click on the **Insert Graphic** button in the **Objects toolbar**.
2. Go to **File** in the menu bar and select **Import...**
3. The **Import Pictures** dialogue box appears.
4. Click on the **Look in:** drop down menu to choose the location where you have the picture you want to insert into the **Art Gallery**.
5. Choose the picture and click on the **Import** button.
6. Automatically the picture is inserted in the **Your Own** collection.
7. To insert this picture into your project you can either select it and click **OK** or double click on the picture.

**Copying and Pasting Pictures from Online Sources**

1. If you are online and you encounter an interesting picture for your **Print Shop** project, you can copy the picture (right click on the picture and select **Copy**).
2. Open the **Print Shop Essentials’** project.
3. Go to **Edit** in the menu bar and click on **Paste Special...**
4. A dialogue box appears for you to select whether you want the image or its link.
5. Click **OK** and the image will be pasted directly onto your project.
Copying and Pasting Pictures from Microsoft Software

1. If you are working in any of the Microsoft software, like Word or PowerPoint and you would like to copy a clipart to a Print Shop project, select this clipart and copy it (right click on the picture and select Copy).
2. Go to the Print Shop project and choose Paste from the Edit dropdown menu. The picture will paste directly on your project.

Inserting Text

1. When you click on the Text/Headline button, you get two options to choose from – Insert Text Box or Insert Headline...
2. Click on Insert Text Box.
3. A text box is inserted in the middle of your page.
4. Double click inside the box to start typing.
5. You can change the size of this textbox from the sizing handles at the corners or sides of the box. Click on a sizing handle and drag outwards if you want to enlarge it or inwards if you want to reduce it.
6. You can also move this textbox to any desired space within the printable part of your project by clicking in the middle of the textbox and dragging it to where you would like it to be.
7. You can also rotate the textbox from the rotating handle on the right hand side of the textbox.
8. It is also possible to connect two textboxes together so that if the text you typed in didn’t fit in the first textbox, it will automatically flow into the second textbox.
9. Create two textboxes by clicking on the Insert Text Box twice.
10. Move the textboxes apart so that they do not overlap.
11. Click on the link button and then click onto the second text box.

NB: This function is especially useful for creating newsletters and brochures.
Inserting Headlines

1. When you click on the Text/Headline button, you get two options to choose from – Insert Text Box or Insert Headline...
2. Click on Insert Headline....
3. The Create a Headline dialogue box appears with various options to choose from.
4. Enter the text you would like as your headline in the top left box and you will see how it will look in the large right box.
5. You can either choose a ReadyMade headline or Customize a headline.
6. If you want a ReadyMade one you can select any of the options in the square examples at the bottom of the dialogue box. You can also scroll down from the right hand side to preview more examples.
7. If you want to Customize the headline, first you have to tick the radio button next to Customize.
8. The options at the bottom of the dialogue box change.
9. From the Font section you can select any font you like for the headline.
10. From just underneath the Font section you can choose bold or italics from the buttons B or I respectively and the alignment of the headline - left, centre, right or justified.
11. You also have a number of tabs all of which give you different options.
12. The Face tab helps you change the colour and offers a variety of ways the colour is put on the headline. If you click on Color you will get the Color Palette dialogue box. From this you can choose any colour, blend style, blend angle or even texture or photo. The colour, texture or photo you choose here will become the inner part of the headline characters. Additionally you can also apply texture or photos by selecting the respective tab in the Color Palette dialogue box.
13. The **Shape** tab gives you the possibility to vary the headline’s shape. If you click on **Color** here, you would be putting a colour background to your headline. This tab also allows you to change the orientation of the headline.

14. The **Position** tab allows you to edit the position of the individual characters within your headline.

15. The **Outline** tab helps you put an outline to the text in different ways as shown in the examples. If you click on **Color** here it will change the colour of the outline.

16. The **Shadow** tab offers you the possibility to put a shadow to your headline. You can choose the shadow colour from the **Color** button or rotate the arrow in the **Depth Angle** section to change the angle of the shadow.

17. The **Depth** tab gives you the opportunity to give a 3D effect to your headline. **Color** here refers to the colour of the depth of the headline (not its face). You can also change the **Depth Angle** by rotating the arrow.

18. The **Proportion** tab is used mainly when you have two or three lines within the heading. It changes the proportion of the various lines.

19. When you have made all the necessary changes to the headline, click the **OK** button at the bottom of the dialogue box and the headline is pasted onto your project.

20. If you need to move it to another place, click in the middle of the headline and drag it to the desired place.
21. If you need to enlarge or reduce the headline, use the sizing handles to click and drag inward or outward.
22. If you need to rotate the headline, use the rotating headline to click and drag to desired angle.
23. If you need to re-edit the headline, double click on it and you will enter the Create a Headline dialogue box again.

Inserting Panel Effects

1. When you click on the Panel Effects button, you get three options to choose from – Backdrop..., Watermark... or Panel Color and Texture...
2. Each of these options will give the project page a background. This background cannot be resized.
3. Backdrops are not recommended for printable projects since they are full of colour and would waste a lot of colour ink to print.
4. Backdrops are ideal for websites since these are not generally printed.
5. Make sure that any text and headlines placed on top of background are legible.

Inserting Backdrops

1. Click on the Panel Effects button and choose Backdrop....
2. The Select a Backdrop dialogue box appears.
3. There is a list of all the available categories on the left hand side and a preview box on the right.
4. Choose any category you like and scroll down the previews to see the options available.
5. Select the backdrop you want.
6. You can edit the Tint to make it look lighter.
7. For black and white backdrops you are also offered the possibility to change the Color too.
8. Click OK to put the backdrop onto you project.
9. If you want to remove the backdrop, go to the Panel Effects button and select Remove Backdrop/Watermark.
Inserting a Watermark

1. Click on the Panel Effects button and choose Watermark....
2. The Create a Watermark dialogue box appears.
3. Type in the text you wish to be seen as a watermark in the first input box.
4. The watermark will show in the Preview box on the right.
5. You can change the Font, Size, Spacing, Color, Tint and the Text Angle.
6. Click OK and the project page will be filled with your watermark.
7. If you want to remove the watermark, go to the Panel Effects button and select Remove Backdrop/Watermark.

Inserting a Panel Colour or Texture

1. Click on the Panel Effects button and choose Panel Color and Texture....
2. The Color Palette dialogue box will appear.
3. If you want a colour as your background, you can choose one from the palette. You can also choose a Blend Style, change the Blend Angle and then click one of the examples in the Select Blend section. Click OK.
4. If you want a texture as your background, click on the Texture tab and select the texture you like and click OK.
5. If you want to remove the panel colour or texture, click on the Panel Effects button and choose again Panel Color and Texture... and opt for None, then click OK.
Inserting Borders

1. Click on the **Borders/Frames** button and select **Border**....
2. The **BorderPlus** dialogue box appears.
3. Here you will have a border made of 8 sections, 4 edges and 4 corners.
4. To fill in the border with a plain colour, click on the **background** button and choose a colour from the palette. All edges and corners will be given the same colour.
5. You can put a graphic repeatedly all around the border.
6. Make sure you have all the border sections selected. If not, go to **Border** in the menu bar and choose **Select All**.
7. Click on the **Art Gallery** button and the **Art Gallery** dialogue box appears. You can choose whichever picture you like. Click on the picture and click **OK**.
8. You can rotate or flip the pictures in the different sections to create continuous pattern by using one of the following buttons:

   ![Rotation and Flip Buttons]

9. When you are happy with your border click on the **Close** button so that the border is placed onto the project.
10. Use the sizing handles to enlarge the border all round the project (or to the desired size).
11. If the pictures are distorted or the border is too thick, double click on it to re-enter the **BorderPlus** dialogue box.
12. To change the width of all the border, move the mouse pointer to one of the inner corners till it changes to a four pointed arrow. Click and drag to change the width of the border.
13. If you only need to change the width of the sides, you can move the pointer to one of the sides till it changes into a double pointed arrow. Click and drag to change the width of the sides of the border.
14. When you are ready close again the **BorderPlus** dialogue box from the **Close** button.
Inserting Frames

1. Click on the *Borders/Frames* button and select *Frame*.
2. The *Select a Frame* dialogue box appears.
3. You can choose one of the *Collections* from the first box or leave it as *All* so that you are shown all the available frames.
4. You can choose which frame you want from the *Frame Types* list or from the previews on the right hand side.
5. The inside of the frame is automatically set as *None* so that whatever you have on your project background is still visible in the middle of the frame.
6. You can opt to put a colour to this inside by clicking on the box called *Fill Inside Area:* and you will be given the *Colour Palette* dialogue box to choose a plain colour or any blend or texture you like to fill in the frame.
7. Click *OK* when you are ready.

Creating Custom Graphics

1. *Print Shop Essentials 11* allows you to create a number of different custom graphics by clicking on the *Create a Custom Graphic* button.
2. You can then choose what type of custom graphic you need.

Creating a Personal Graphic

1. Click on the *Create a Custom Graphic* button and select *Personal Graphic*.
2. You can select the graphic you want from the list called *Graphics*.
3. If you don’t find anything to your liking, you can click on the *More Graphics* button to choose a picture from the *Art Gallery*.
4. For monochrome pictures (black & white) you can also change their colour by clicking on the button next to **Color**.

5. The **Tint** can be used to create lighter pictures from your custom graphics.

6. The custom graphic has text on it and you can edit this text from the input box under **Enter Text** which is exactly under the **Editable Preview** box.

7. Text attributes can be edited from the middle column of the dialogue box.

8. You can select one of the **Text Styles** available, change the **Font**, select bold or italics and a colour for the text.

9. The preview box is called **Editable Preview** since both the picture and the text can be directly edited within this preview box. If you click on any of them you will be given the sizing handles to resize the object or even rotate it.

10. When you are ready from your custom graphics click **OK**.

### Creating an Initial Cap or Fancy Letter

1. The initial cap is used when you want to put a decorated letter at the beginning of a paragraph but it could also be used to create fancy single letters.

2. Click on the **Create a Custom Graphic** button and select **Initial Cap**....

3. The **Create an Initial Cap** dialogue box appears and you can type the letter you want to embellish in the **Enter Letter** input box underneath the **Editable Preview** box.

4. You can select a graphic for the background of the letter from the **Graphics** list.

5. If you don’t find what you’re looking for, click on the **More Graphics** button to enter the **Art Gallery** and select from there.

6. You can change the colour of monochrome (black and white) graphics from the button next to **Color** and change the darkness of the picture from the dropdown menu next to **Tint**.

7. From the middle section of the dialogue box you can change **Effects** related to the letter, the **Font**, **Style** and **Color**.

8. You will see all the changes in the **Editable Preview** box.

9. If you click on the letter or the picture within the **Editable Preview**, you can move them around, resize them from the sizing handles or rotate them.

10. When ready click **OK**.
Creating a Fancy Number

1. Creating a fancy number is very similar to creating an initial cap.
2. Click on the Create a Custom Graphic button and select Number....
3. Follow the same directions as those for the initial cap.
4. The only difference is that the Create a Number dialogue box also offers the possibility to tick the Smart Suffix box to get ordinal numbers ($1^{st}$, $2^{nd}$, $3^{rd}$...).

Creating a Seal

1. Click on the Create a Custom Graphic button and select Seal....
2. Enter the text you want at the top of the seal in the first input box and the text you want at the bottom in the second input box.
3. You can change the Font, Color and Style of the text.
4. You can insert two kinds of graphics for the seal, one for the edge and one for the centre.
5. If the graphics chosen are monochrome (black and white) you can select a colour for them too.
6. When you are ready just click on OK and this seal will be pasted on your project.

Creating a Clock

1. Click on the Create a Custom Graphic button and select Timepiece....
2. The Create a Timepiece dialogue box appears and you can put the time you want to show on your clock in the Hour: and Minutes: input boxes.
3. Select the picture of the clock you want from the list available and you will see it in the Preview box on the right.
4. Click OK to place the clock on your project.
Creating a Signature

1. Click on the Create a Custom Graphic button and select Signature…
2. The Create a Signature dialogue box appears.
3. You can choose a ready-made signature from the list of Famous Signatures or leave it blank by choosing None.
4. Under the signature line you could put in any text you like from the input box called Enter Text: and you can change the Font, Style and Color of this text.
5. Click OK to put this signature onto your project.

The Photo Workshop

1. You can apply certain attributes or edit pictures through the Photo Workshop available in the Print Shop Essentials 11.
2. Please note that before clicking the Photo Workshop button you must click on the graphic to which you want to apply changes.
3. Click on the Photo Workshop button and select from the various attributes and editing facilities available. All these features offer more options to choose from.
4. The Apply Drop Shadow... allows you to put a shadow to your picture. From the Customize Shadow tab you can also choose the direction of the shadow, transparency, edge softness and colour.
5. The Apply Radiant Glow... allows you to put a glow all round the picture. From the Customize Glow tab you will be able to choose the thickness of the glow, its transparency and even its colour.
6. The Apply Special Effect... allows you to select from the tabs called Soft Edges, Special Edges, Outline Edges and Transparent Effects to the picture.
7. The Crop & Orientation... opens the Photo Workshop dialogue box from where you can also select the
tabs called Adjust Color..., Brightness & Focus..., Fix Flaw... and Artistic Effects...

8. The Crop & Orientation is used to cut a part of the picture. You can choose a ready-made shape to cut out the picture and use the sizing handles to resize the cutter, then press the Cut It button to actually cut the picture. You can also rotate the picture to 90° in the Orientation section.

9. The Adjust Color tab allows you to change the colour of the picture.

10. The Brightness & Focus tab allows you to change the brightness, contrast, blur/sharpen and saturation of the picture.

11. The Fix Flaw tab allows you to edit red eye, pet eye, dust and scratches and shiny faces.

12. The Artistic Effects allows you to put fancy filters to the picture.

13. The Photo Workshop also allows you to directly import a picture to Print Shop Essentials 11 or to acquire it from a scanner.

Creating Tables

1. Click on the Table button and the Create Table dialogue box appears.

2. You can type in the amount of rows and columns you need and choose a format you would like from the Table Formats: list.

3. You can preview how the table will look in the Sample: box.

4. Click OK to put the table onto your project.

5. Use the sizing handles to resize the table.

6. Click in the cell you want to put text and type it in.

7. To move to the next cell, you can click on the Tab button on your keyboard.

8. If you want to resize a specific column, move the mouse pointer onto the grid between the columns till you get a double pointed arrow, click and drag to reduce or enlarge the column.

9. In the same way you can alter the height of the rows.

10. To do some editing, like font, style... you can highlight a whole column or a whole row by moving the mouse pointer out of the table on top of a column till you get a tick down arrow and click to highlight, or move the mouse out of the table to the left hand side of the row till you get a thick right pointing arrow and click to highlight.

11. Tables can also be edited from the Table menu in the menu bar.

12. From this menu you can format cells, insert more rows or columns, delete rows or columns, and also merge cells.
NB: Rows and columns to be edited need to be selected (highlighted).

Using the Drawing Tools

1. Go to the Drawing Tools button and select the kind of drawing you would like to do, whether it is a shape, line or freehand drawing.

2. If you opt for the Insert Shape..., the Add a New Shape dialogue box appears. You can choose one of the shapes shown at the top or click on the More button to select any other available shape. You can select the colour of the inside of the shape or tick the Hollow box if you want the shape to only have an outline. The colour of the outline and its width can also be varied. You will see a preview in the Preview box and when you are finished with the shape you have to click OK to put it onto the project.

3. If you opt for the Insert A Line..., the Line Format dialogue box appears, where you can change the Line Width, Line Style and Line Color. When finished you can click OK to put the line onto the project. It is automatically inserted as a diagonal line, but you can rotate the line or resize it from the sizing handles at each end.

4. If you wish to re-edit the line, you can select it and go to the Drawing Tools button and opt for Line Format... or else double click on the line, to re-enter the Line Format dialogue box again.

5. If you would like to draw freely you have to choose the Draw Freehand option and the mouse pointer turns into a + sign and you can click, drag and draw whatever you like. Once you release the mouse button, the line you have drawn will become the image. If you want to add more lines to the first one, you will have to go to the Drawing Tools button again and select Draw Freehand again.

6. The Drawing Tools button also allows you to move onto a more specialized drawing program called Draw Plus by choosing the Advanced Drawing... option.

Zooming in and out of the Project Page

1. At the bottom of the screen you will find the zooming toolbar.
2. This works with the project page size. You can decrease the view to be able to see all the page or increase the view to be able to see certain items on your project in more detail.

**Saving and Opening a Project**

1. When you have created your project and would like to save it for the first time, click on the **File** menu.
2. Select the **Save** option within this menu and the **Save As** dialogue box opens.
3. Find the location where you would like to save your project from the **Save in:** dropdown menu.
4. Type in a file name for your project and click on the **Save** button.
5. If you would like to resave it after doing some editing to it, you can go again to the **File** menu and select the **Save** option. This time you will not given any dialogue box since it will save upon the older version, thus you will lose that version to have the current one saved.
6. If you want to reopen the project, go to the **File** menu again.
7. Select the **Open...** option and the **Open Project From Disk** dialogue box appears.
8. Select the item location from the **Look in:** dropdown menu.
9. Choose the filename of your project and see its preview in the **Preview** box.
10. Click on the **Open** button to open your project.

**Arranging Objects**

1. When you have more than one object on the project page, you might need to arrange the items so that they look better together.
2. Click on the item you would like to arrange and go to **Arrange** menu in the menu bar to see what attributes you can arrange.
Changing the Position and Size

1. Click on the item you want to change its position and click on **Arrange** in the menu bar.

2. Select **Position** or **Size** and a dropdown menu appears to select from. You can choose **More...** and the **Position & Size** dialogue box appears.

3. You can change both the **Horizontal** and **Vertical** positions from the **Position** tab.

4. In the **Size** tab you are allowed to change the amount of **Width** and **Height** space the object will take from your project page or select a specific width or height in inches.

5. You can also use the **Scale:** input box to reduce or enlarge the object according to percentage.

6. Click **OK** to turn to the project page or **Reset** if you want to undo all the changes you made to this object.

7. If you have more than one object selected and choose the Position or Size option from the Arrange menu, you will get a third tab called **Relative** which offers you to arrange the objects in relation to one another. This tab offers you to set the **Horizontal** and
**Vertical Alignment** of objects and their **Width** and **Height** to make all pictures of the same size.

**Rotating, Flipping and changing Objects’ Layers**

1. Objects can be rotated from the rotating handle but if you wish to rotate them to an exact angle you can go to the Arrange menu and select Rotate, then choose either **Left 90 degrees**, **Right 90 Degrees** or **Other...**
2. If you choose **Other...** you will get the **Custom Rotation** dialogue box from where to input the exact degree number.
3. To flip an object you can click the middle sizing handle from one of the sides and drag it across the picture to the other side and it will be automatically flipped. This might distort the image size. If you would like to have smooth flipping you can go to the Arrange menu and select **Horizontal**, **Vertical** or **Both**.
4. Sometimes you get objects overlapping others and you need to change their layers so that you put one object under another or in front of another. To do this you can go to the Arrange menu and choose one of the options to bring the item forward or backwards.

**Wrapping Text**

1. If one of the objects is a textbox, you might have some text hidden by any other object on a layer in front of it. If you send this item to a backward layer the text will be over the item but some of it might not be legible due to the colours of the bottom object.
2. You can have the text put at a bottom layer and then wrapped around the top object.
3. Go to the Arrange menu and select **Wrap Text...** to get the Text Around Graphic dialogue box and select any option you feel fit for your textbox.
Hints and Tips according to Project Layouts

**Banners**

1. When you start a new banner you will get the word *Banner* on it. If you double click on it, you will highlight it and can delete it and type in your text.

2. The number of pages for your banner will increase with the amount of text you write.

3. The shape of the text will be rectangular but you can choose a different fancy shape if you like. Go to *Edit* in the menu bar and select *Banner Text Shape...* to open the *Text Shape* dialogue box and select the shape you want then click *OK*.

4. You can edit the font and size from the *Text toolbar* after highlighting the text.

5. If you would like to omit this text and create your own headlines and graphics normally, you can just delete the word banner and then insert the objects you want.

6. To increase the number of pages within a banner, you can drag an object to the furthest right till the banner length increases. You can repeat this till you get the amount of pages you need.

**Brochures**

1. Brochures can be used to create booklets, flyers, flash cards or game cards so you have to decide what you want to do before starting this project.

2. To create an A5 booklet from the *Select a Format: section you have to choose Wide and the Number of Panels: has to be set to 2.*

3. This will be made up of the outside and inside of an A4 which will then be folded into an A5, so you will get a dotted line in the middle of the project page to help you place the items you wish on two pages of the *Outside* view.

4. To move to the *Inside* view you have to click on the right arrow next to the word *Outside* at the bottom of the screen (next to the *Zooming toolbar*).

5. When printing this project you have to insert the paper twice to print on both sides of the paper, or print out on two separate papers and stick them together.
6. To create a flyer, from the **Select a Format:** section you have to choose **Wide** and **3** from the **Number of Panels:** section. You will get 3 vertical sections separated by a dotted line (which doesn’t print) to serve as a guide to create the flyer. This project also gives you the **Outside** and **Inside** view to toggle from since it can create double sided flyers.

7. To create flash cards or game cards, it is advisable to choose **Tall** and **3 or 4** from the **Select a Format:** section, since it gives you three or four horizontal spaces separated by a dotted line (which doesn’t print). You can use the dotted lines as guide lines to create 3 or 4 flashcards. For game cards, you can divide vertically each section so that you can create 6 or 8 game cards per page. If you move to the **Inside** view you can then create 3 or 4 more flashcards or 6 or 8 more game cards.

**Greeting Cards**

1. Apart from creating greeting cards, this layout can also be used to create A5 or A6 booklets or card games.
2. You have to decide what you wish to do before starting the project and then select the format you want from the **Select Card Type:** section.
3. Use the **Quarter-Fold** to create A6 booklets or cards for games which will be of the size of quarter of an A4 page.
4. Use the **Half-Fold** for A5 booklets. This will open on the Inside
5. These layouts will open on the **Front** of the project. You can move to the **Inside** panels or the **Back** panel from the bottom of the screen.

**Newsletters**

1. The Newsletters layout is very useful to create consecutive pages within the same project. You can create class magazines or newsletter through it but it can also be used to create an A4 book or a sequence of A4 worksheets related to the same topic.
2. After creating the first page, to insert another page to this project you can click on the right arrow of the pages toolbar at the bottom of the screen.
3. The **Add Pages** dialogue box appears and you can type in the number of pages you wish to add in the first input box. You can also choose to add them after the current page or before and from the **Contents** section you can decide whether you wish to **Add Blank Pages** or to **Add Copies Of Page**
4. Click **OK** and the page/s are inserted.
5. Move to and fro through the project pages from the pages toolbar at the bottom of the screen.

### Postcards

1. Postcards offer you the possibility of creating one card and printing two, three or four exact copies on one A4 sheet.
2. When you are starting the **Postcards** layout, from the **Select a Postcard:** you can choose the type of postcard layout you wish. A preview of the number of cards per A4 page will be given on the right.
3. This project layout is **ONLY** useful when creating exact copies of the card created since the other cards will be exactly the same and none of the objects can be edited.
4. For this layout you will get the possibility to create both the **Front** and the **Back** of the postcard and you can toggle between the two from the panel bar at the bottom of the screen.

### Signs

1. The **Signs** layout is very useful to create A4 handouts and worksheets, but it is also ideal to create charts and posters, since at the printing stage you can opt to print this project over more than one sheet of A4.
2. In the **Print** dialogue box you get the **Output Size** button which is by default set to **100%**. If you click on it will give you the **Custom Print Size** dialogue box which allows you to vary the width and length of the output chart or poster.
3. You can type in the exact centimetres of the width and height or you can type in the number of sheets wide or tall you wish your poster to be printed upon, or you can use the **Scale:** input...
Creating Printable and Online Resources through PrintShop Essentials 11

1. When creating a new website, before even starting, it is wise to plan what you wish to put into a website.

2. A website is a number of web pages linked together through hyperlinks which could be made out of buttons, text, graphics or hotspots. The website could also be linked to other websites, documents, programmes or email addresses.

3. Very often the first page of a website would contain the title and aim of the site and the links to all the other pages according to subtopics. Some sites are also sequentially linked so that from the first page you move on to the next, and then the next and so on.

4. It is also important that a website contains the name of the webmaster and/or author and his/her contact details since this gives the website more credibility.

5. Putting the date of when the site is uploaded and updated will also be useful. It will indicate to the viewer whether the information within the site is still relevant.

6. Care should also be given to the colours and text fonts used. Keep it in mind that the text has to be clearly legible, especially by the age group of the viewers the website is targeted for.

7. When starting the **Web Pages** project select **Custom** in the **Page Width:** section and then type in 800 in the **Width** input box and 600 in the **Height** input box. This will create a horizontal page layout, similar to a monitor’s screen layout.

8. Since a website is not aimed at being printed, it is highly recommended that a backdrop or panel colour is given to the page to make it more attractive to the viewer.
9. You can add any items to a web page; graphics from the *Art Gallery*, imported graphics, headlines, textboxes, custom graphics and even borders.

10. To insert more pages, you can go to the pages toolbar at the bottom of the screen and click on the right arrow so that you get the *Add Pages* dialogue box. Type in the number of pages you wish to add, tick any other option from the dialogue box and then click *OK*.

11. You can move from one page to another from the left and right arrows in the pages toolbar.

12. When you are running the website as a stand-alone you will not have the pages toolbar available, so you’ll need to create links from one page to another to navigate easily when viewing the site online.

13. If you want to use a graphic or headline to link you to another page, site, document or email, select the graphic and go to *Web* in the menu bar. Choose *Links...* and the *Hyperlink* dialogue box appears. Here you can select with what you wish to link.
a. If you tick **Internet Document** you will get an input box at the bottom of the dialogue box to type in the website address you wish to link to. This usually starts with **http://**.

b. If you tick **An Internet e-mail address** you will get an input box at the bottom of the dialogue box to type in the email address you wish to link to. This always has the @ sign in the middle of it.

c. If you tick **A page in your project** you will get a list to tick to which page you wish to link the object and an input box to type in directly the page number.

d. If you tick **A file on your system**, you will be given a **Browse...** button to find the file you want to link.

14. If you wish to link text or any other part of the background, you cannot use the **Links...** feature but you can create a hotspot over them which will then be linked. Go to **Web** in the menu bar and select **Hotspots**. The mouse pointer changes into and you can draw a rectangle round the text or background you wish to act as a button to link to something else. Once you finish the hotspot the **Hyperlink** dialogue box opens offering you all the above possibilities.

15. **Print Shop Essentials** gives you the opportunity to preview your website before publishing it. Go to **Web** in the menu bar and click **Preview Web Site**.

16. When you are pleased with your website, it is time to publish it – publishing means making the software turn your pages into a real website. Go to **Web** in the menu bar and choose **Publish to Folder**.

17. If the **Overwrite Confirmation** dialogue box appears click **Yes**.
18. Then the **Choose Directory** dialogue box appears.
19. In the **Directory Name** type in a name for your folder. *(For example: classweb).* In the **Drives** see that you have **C:** which means it will be saved on the hard disk of your computer. *(If you want to save the web onto a pendrive, select it’s drive name from here.)* Click **OK**.
20. If the **Web Page Design Checker** dialogue box appears, just click **Continue**.
21. This will create a folder in the **C:** (hard disk) containing all the items of the website.
   **NB: All the items will be saved separately and not with the web pages, including graphics, headlines, background panels or colour, borders. The only thing which saves with the webpage is the text written within textboxes.**
22. To locate where the folder has been created, go to the **Start** button in the taskbar at the bottom of the screen. Find **My Computer** and find the folder with the name you had given when publishing it. *(For example: classweb).*
23. Double click on the folder to see its contents.

24. The files with the Internet Explorer icon and with the *.html* extension will be the web page files. The others will have a *.gif* or *.jpg* extension and will be treated as graphics, even though they might have been background, borders or headlines.
25. To view this site in a web browser, double click on the file called **default.html** and it will open in the default browser of your computer *(like Internet Explorer or Mozzilla).* The website will be viewed on your computer only or if it is saved on a pendrive, on the computer reading from that pendrive.
26. If you want to upload the website to the Internet, you will have to upload all the separate items to the web space available.
   **NB: All state school academic staff and pupils might be given free web space to upload their website. If you want to apply for web space go to** [http://skola.gov.mt/skola/webhosting/getwebhosting.aspx](http://skola.gov.mt/skola/webhosting/getwebhosting.aspx)